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1 INTRODUCTION 

DMX (Digital Multiplex) is a control protocol in the event technology and therefore has a solid, reliable 
and simple design. The standard in its current form has existed since 1990. Due to its popularity, it 
offers a wide range of functions at low acquisition costs.  
 
The DUODMX GATEWAY has a network interface (LAN and WLAN, depending on the variant) and two 
independently configurable DMX outputs (DMX worlds) with 512 channels each, allowing you to 
control, for example, two rooms/areas separately.  
The DUODMX GATEWAY can be operated as a DMX master or slave. The gateway sends DMX packets in 
master mode and receives them in slave mode.  
Nine different device variants position the DUODMX GATEWAY ideally for usage in almost any required 
scenario. The device is used as DMX gateway for KNX®  or EnOcean®  systems but can also be operated 
as a standalone device ² straight with a native App for iOS® and Android® smartphones for particularly 
easy operation. 
 
The professional configuration software not only enables you to dim individual channels, but also to 
program complex sequences.  
 
The DUODMX GATEWAY is highly suitable for subsequent installation as a device installed in the ceiling. 
A corresponding adapter is available for top DIN rail installation.  
In addition to the recessed ceiling version, the DUODMX GATEWAY is also available as REG (Modular 
device (REG) housing 4 units). 
 
 

2 THE GATEWAY 

The DUODMX GATEWAY is a ceiling installation device, and its compact size also enables specific 
installation situations. The REG variant (Modular device housing), on the other hand, is for installation in 
distribution boxes. The device has 2 separate DMX interfaces which are controlled separately. 
Specifications: 
 
Power supply:  
Á Power over Ethernet (PoE)  (via RJ-45 except REG variant) 
Á Terminal:    12-32VDC 
Á Power consumption:   <= 1.2W 

 
Mechanical data:  
Á Assembly:    Ceiling installation / DIN  rail adapter: 

Modular device housing 4 MW 
DIN rail EN 50022 ² 35x7.5  

Á Dimensions (W x H x D) in mm:    
Ceiling installation   without  fastening lugs: 50x26x116  

with fastening lugs: 50x26x146  
 Modular device housing   70x90x63  
 
Interfaces (model -dependent):  
Á KNX     via terminal (twisted pair) 
Á Network    via RJ45 connection 
Á Wireless network   via external SMA antenna (except REG variant) 
Á EnOcean    via external SMA antenna (except REG variant) 
Á 2xDMX 512    terminal, conductor cross-section: 1.5mm² 
Á Input feeler    terminal, conductor cross-section: 1.5mm² 
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2.1  VARIANTS 

Standalone device variant (item no. 12041)  
As a standalone device, the Gateway receives the DMX commands via the smartphone APP ¯DUO DMX 
APP°. The device is connected to the network via a LAN cable. 
 
WLAN standalone device variant (item no. 12041w)  
It is similar to the standalone variant. The DUODMX GATEWAY is connected with the network via WLAN 
instead of LAN. 
 
IP device variant (item no. 12011)  
As IP variant, the device receives its control commands via the ¯KNXnet/IP° protocol.  
The KNX telegrams are sent and received via the KNXnet/IP routing protocol. 
Therefore, the device must be connected with the network.  
 
IP WLAN device variant (item no. 12011w)  
It is similar to the IP variant. The DUODMX GATEWAY is connected with the network via WLAN instead of 
LAN. 
 
IP SR device variant (item no.: 12111)  
The IP SR variant does not only allow for the sending of DMX commands due to incoming KNXnet/IP 
telegrams (see IP variant above) but also sends KNXnet/IP telegrams due to incoming DMX commands.  
The KNX telegrams are sent and received via the KNXnet/IP routing protocol. 
Therefore, the device must be connected with the network. The master/slave function (send/receive) 
can be adjusted separately for each DMX interface.  
 
IP SR WLAN device variant (item no.: 12111w)  
It is similar to the IP SR variant. The DUODMX GATEWAY is connected with the network via WLAN instead 
of LAN. 
 
KNX device variant (item no.: 12021)  
As KNX twisted pair variant, the device is directly connected with the KNX bus.  
The KNX telegrams are sent and received via the KNX bus. 
In addition, KNX telegrams can also be received via network using the KNXnet/IP routing protocol. 
For operation, network connection is not required. 
 
KNX SR device variant (item no.: 12121)  
The KNX SR variant does not only allow for the sending of DMX commands due to incoming KNX/TP 
telegrams (see KNX variant above) but also sends KNX/TP telegrams due to incoming DMX commands. 
The master/slave function (send/receive) can be adjusted separately for each DMX interface.  
The KNX telegrams are sent and received via the KNX bus. 
In addition, KNX telegrams can also be received via network using the KNXnet/IP routing protocol. 
For operation, network connection is not required. 
 
EnOcean device variant (item no.: 12031)  
As EnOcean variant, the device receives the control signals via the EnOcean radio system. The device 
only requires power supply. Moreover, an external antenna must be connected to the device. The DMX-
Configurator software enables the connection with the EnOcean profiles. For operation, network 
connection is not required. 
 
KNX SR device variant REG (item no.: 12521 ) 
The "KNX SR REG" variant is largely identical to the KNX SR device variant (item no.: 12121).  
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3 ASSEMBLY 

3.1  CEILING INSTALLATION VARIANT 

The device can be used for ceiling installation but also for DIN rail assembly. For ceiling installation, the 
device is equipped with fastening lugs at two sides.  
For DIN rail assembly, an adapter can be provided as an option. The fastening lugs are designed so that 
they can be dismantled on demand. 
 

 
Figure 1: DUODMX GATEWAY with lugs 

 
DIN rail adapter  
The adapter is mounted to the housing with two screws included in the scope of supply. Make sure that 
the adapter is screwed to the housing through the two grooved holes only. These two holes are marked 
by the red circles on the picture. 
 

 
Figure 2: DIN rail adapter 

 
Note: Please use the two mark ed holes if you assemble the DIN  rail adapter to the DUODMX 
GATEWAY. If you do not use the correct holes, the screw ends may touch the bottom side of the 
circuit board!  
 
Please be careful if you want to loosen a device mounted on the DIN rail from the rail. If you apply 
excessive force when removing the gateway, the screws of the adapter might be ripped out from the 
housing. 
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3.1.1  CONNECTION DIAGRAM 

The following figure is an overview of any available connection variants of the DUODMX GATEWAY. 
 

 
Figure 3: DUODMX GATEWAY ² connection diagram 

 
 
Connection with the DMX bus  
The device has two independently operating DMX interfaces. Depending on the type of device, the 
interfaces can be configured as DMX master (sending) or as DMX slave (receiving) on demand. The 
device is connected via a 6-pin pluggable screw terminal, polarity is indicated on the housing. It is also 
possible to use just one DMX output. The connections are short-circuit -proof (for device type SR) and 
can be bypassed.  
 

NOTE:  

- DO NOT CONFUSE the pluggable screw terminals (power  supply side and DMX connection 

side)!  

- Please take care of the correct polarity when installing the power supply!  

At the end of this document you will find a description of the assignment of DMX connectors and 

sockets. 
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3.2  MODULAR DEVICE HOUSING VARIANT 

The device is used for DIN rail mounting, according to DIN EN 60715, in a REG housing 4 units. 
Dimensions (width x height x depth): 70 x 90 x 63 mm 
 
Á So that the power supply and the DMX bus cable can be connected conveniently, the screw-

type plug-in terminals (see connection diagram below) are removable. 
 
Á At first, connect the cables of the power supply as well as the DMX bus cable to the screw 

terminals (see figure below). Please note the polarity! 
 

Á Afterwards, the screw-type plug-in terminals can be reconnected to the DUODMX GATEWAY. 
 

Á The device can now be snapped onto the DIN rail, according to DIN EN 60715. 
 

 
Figure 4: DUODMX GATEWAY REG 
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3.2.1  CONNECTION 
DIAGRAM 

The following figure is an overview of any available 

connection variants of the DUODMX GATEWAY REG 

variant. 

Connection with the DMX bus  
The device has two independently operating DMX 
interfaces. Depending on the type of device, the 
interfaces can be configured as DMX master (sending) 
or as DMX slave (receiving) on demand. The device is 
connected via two  3-pin pluggable screw terminal; 
polarity is indicated on the housing. It is also possible 
to use just one DMX output. The connections are short-
circuit-proof (for device type SR).  

 

Figure 5: DUODMX GATEWAY ² connection diagram 

 

1. SD Memory Card Slot 

2. button  

3. LEDs 

4. KNX/TP connection  

5. potential -free pushbutton interface  

6. power supply 

7. Ethernet connector 

8. DMX interface 2 

9. DMX interface 1 

 

NOTE:  

- DO NOT CONFUSE the pluggable screw t erminals (power  supply side and DMX connection 

side)!  

- The polarity is indicated on the housing  

- Please take care of the correct polarity when installing the power supply!  

THE CONNECTIONS MUST NOT BE EXCHANGED!  
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4 INITIAL OPERATION 

As a ceiling installation or REG device, the gateway can be installed close to the DMX system. You 
require the following components for operation:  
Á power supply (conventional or PoE) 
Á network connection (not mandatory but advantageous for configuration)  
Á DMX bus connection 
Á connection to one of the control media (network, KNX or EnOcean) 
Á DMX-Configurator software 

 
The device is configured with the DMX-Configurator software via the network or an SD card. For this 
purpose, the device variant is unimportant.  
 
IMPORTANT NOTICE: If you con figure the device via the local network, the PC must be in the same 
IP address range as the DUODMX GATEWAY. 
If configuration via the network is not possible, the project data can also be transferred with an 
SD card. SD cards in NTFS format are not supporte d!  
In case that DUODMX cannot be found, you must deactivate all network interfaces except for the 
currently used network interface!  
Please take care of the correct polarity when installing the power supply!  
 
For this purpose, you need a commercial SD card (FAT format) and a card reader for your PC!  
 
 

4.1  DMX-CONFIGURATOR INSTALLATION 

First of all, you must install the DMX-Configurator software. The setup file for the installation of the 
software is on the enclosed CD or can be downloaded at www.bab-tec.de.  
 
Installation instructions:  
Double-click on the setup.exe file. The setup dialogue opens up: 
 

 
Figure 6: DMX-Configurator setup dialogue 

 
Click on Next to navigate through the menu. Confirm the licence agreement and select a place of 
installation on the hard disk. Finally select Finish so that the installation wizard will start installing the 
program.  
 
Now you will find the program at Start > Programs > BAB TECHNOLOGIE GmbH > DMX-Configurator. 
  

http://www.bab-tec.de/
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4.2  DMX-CONFIGURATOR UPDATE 

If you want to install a newer version of the DMX-Configurator, it is important that you correctly uninstall 
the previous version beforehand. To this end, you must go to Start > System control > Programs and 
Functions (Software in Windows XP) and uninstall the DMX-Configurator. Select the new setup file now 
and proceed as described above. 
 
 

4.3  FACTORY SETTINGS 

The DUODMX GATEWAY is supplied with the following factory settings: 
 
Á IP address:     192.168.1.223  
Á Subnet mask:     255.255.255 .0 
Á Device name:     MAC address of the device 
Á Physical KNX address:    15.15.255  
Á Multicast address KNXnet/IP (¯routing°):224.0.23.12  

      (can be changed as of firmware version 2.2.0.0)  
Á EIBPORT system ID:    0  

      (cannot be changed) 
 
In addition to t he firmware, there is also a DMX-Configurator sample project in the installation registry 
of the DMX-Configurator software. If necessary, it can be used to overwrite the loaded project in the 
DUODMX GATEWAY. 
 
 

4.4  INITIAL COMMISSIONING 

As a first step, connect a conventional 12-32V power supply (DC) to the appropriate pluggable screw 
terminals or to a PoE network connection (Figure 3) and connect the DUODMX GATEWAY to the 
network. The green power LED is continuously on once the device has been started.  
The second step is the configuration of the network settings. 
 
For configuration, the PC must be in the same IP address range as the DUODMX GATEWAY.  
If it is not possible to change the network settings of the PC, you can alternatively trans fer the 
network settings by means of an SD card.  
 
Á Start the DMX-Configurator and switch to the menu screen Extensions ² DUO-DMX GATEWAY. 

 

 
 

Figure 7: DMX-Configurator ² extensions 
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Á You are prompted to enter your device type. You have the following options (next figure): 

 

 
 

Figure 8: DMX-Configurator ² type selection 

 
 

a) KNX/BMX is for the following device types:  
o Standalone (item no. 12041) 
o IP (item no. 12011) 
o KNX (item no. 12021) 

 
b) KNX/BMX master/slave is for the following device types: 

o IP SR (item no. 12111) 
o KNX SR (item no. 12121) 

 
c) EnOcean is for the following device type:  

o EnOcean (item no. 12031) 
 

d) WLAN is for the following device types: 
o WLAN standalone (item no. 12041w) 
o IP WLAN (item no. 10211w) 

 
e)  WLAN master/slave is for the following device type:  

o IP SR WLAN (item no. 12111w) 
 
Depending on your selection, various configuration windows are provided. For a detailed description, 
please read the chapter ¯Extensions°.  
 
Please note: If you configure the d evice via the local network, the PC must be in the same IP 
address range as the DUODMX GATEWAY. 
If configuration via the network is not possible, the project data can also be transmitted with an 
SD card. 
 
Á The network settings of the device can be accessed as follows:  

For  
o KNX/IP, KNX/IP SR, select the LAN/KNX tab. 
o WLAN and WLAN SR, select the LAN/KNX tab. 
o EnOcean, select the LAN/EnOcean tab. 

 
The figure below shows the configuration for the KNX/BMX variant as an example. 
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Figure 9: DMX-Configurator ² device search 

 
 
 
Á Press the Search button (orange arrow) below the DMX-Gateways field. All DUODMX GATEWAYs 

in the network are displayed, irrespective of the IP address settings of the PC.  
 
Á On the basis of the search result (the displayed IP address) you must now check whether it is 

necessary to adjust the IP address of the DUODMX GATEWAY or not. 
 
 
Á If adjustment is necessary, make the required settings in the fields provided for this purpose (IP 

address, subnet, gateway).  
 
Á Do not change the Multicast address unless this is required. 

 
Á Then close the Extension window and save the project with File > 

Save. 
 
 
 
 

CONFIGURATION UPLOAD via the network 

 
Á Mark the DUODMX GATEWAY to which you want to upload the 

configuration.  
 
Á Press the Upload button to start the upload. The message Upload 

completed  will show you that your upload has been successfully 
completed.  

(blue arrow)  Figure 10: Adjusting the network settings 
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SAVING THE CONFIGURATION via SD card: 
 
Á Close and acknowledge the configuration with OK. 

 
Á Save the project (File > Save or Save as) 

 
Á Open the File menu again and save the project by means of 

the Export HEX File under a unique name in the desired 
folder.  

 
Á Insert your SD card in your card reader and make sure that 

the SD card does not contain any data.  
 
Á Then copy the generated HEX file onto the SD card and 
rename it to ¯config.par°.  

 
Á Insert the SD card into the slot of the DUODMX GATEWAY 

during operation. The status LED of the device will go out for a 
short while for reading the data.  
As soon as the green status LED is on again, the configuration is loaded.  

 
 
Please note: Only SD cards with FAT file system format are supported!  
 
Third and last step of the network configuration: 
Á Restart the device by pressing the power button.  

 
Á Open the DMX-Configurator and check, as described in the steps above, whether the new IP 

address settings have been applied to the DUODMX GATEWAY. From now on, you can transfer 
any configuration changes directly via the network (see chapter ¯Transmission of configuration 
files°).  

 
 
Further information is provided in chapter 5.5.2.3 . LAN/KNX 
  

Figure 11: Saving the project 
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4.5  IMPORTANT INFORMATION ON THE VERSION 

Important notice: Please check for the most current version for both modules (software and 
firmware).  
 
Reading th e software version  
The version number of the DMX-Configurator can be read from the title bar of the window.  
 

 
Figure 12 : DMX-Configurator version 

 
Reading the firmware version  
Use the Search function in the LAN/KNX tab, LAN/EnOcean tab or WLAN tab in the Extension menu to 
find out which firmware your device is using (see also chapter ¯Activation of the (DMX) preview°). The 
firmware version is displayed together with the IP address and the device name. 
 

 
Figure 13: Display of the firmware version 

 
If your device does not have the most current firmware version, you must make a firmware update (see 
chapter ¯Firmware update°). Once your DUODMX GATEWAY has been equipped with the firmware 
2.0.0.1 or higher, the  configuration data can only be transmitted by the DMX-Configurator 1.6.0.0 or 
higher.  
 
Older project data  
Projects from older software versions can be opened with the current DMX-Configurator without any 
problems. If you have commissioned your DUODMX GATEWAY with an older DMX-Configurator version, 
this version must be reloaded to the DUODMX GATEWAY once more using the current DMX-
Configurator (1.6.0.0 or higher).   
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4.6  DEVICE BEHAVIOUR IN CASE OF POWER 
FAILURE AND SWITCHING ON THE POWER 
SUPPLY AGAIN 

Device behaviour in case of power supply failure  
The behaviour of the DMX end devices in case of power supply failure at the DUODMX GATEWAY 
depends on the end devices. According to the DMX specification, components will switch to a save 
operating status (e.g. lamp off).  
 
 
Behaviour when the power supply is switched on again  
Once the supply voltage has been restored, all 512 DMX channels on both DMX interfaces are set to 
"0" by default.  
In the scene configuration it is also possible to trigger a selected ¯Start scene° after switching on the 
power supply of the DUODMX GATEWAY. 
In this way, it is possible to determine whether the lighting should be switched on or a scene should be 
start without further action.  
The configuration is carried out in the corresponding  
field "Default scene on start", select in this field the  
desired scene. 
 
 

 
Figure 14 Choose Default Scene on Start 

 
 
Behaviour in case of bus voltage failure (only KNX/TP device)  
If the bus voltage fails but the power supply of the devices can be maintained, only the control of the 
DUODMX GATEWAY is interrupted. The DMX signal is still sent so that the current ¯image° of the DMX 
output is maintained. The restoration of the bus supply does not change anything for the DMX (unless 
there are new KNX telegrams). 
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5 PROGRAMMING 

The DUODMX GATEWAY is programmed via the DMX-Configurator. In the DMX-Configurator, scenes are 
created which connect group addresses or EnOcean profiles with the dimmer channels or the scenes. 
The configuration is transmitted to the device via the network or via the SD card.  
 
IMPORTANT NOTICE: In case that the DMX-Configurator cannot find the DUODMX, you must deactivate 
all network interfaces except for the currently used network interface! 
 

5.1  ACTIVATING THE (DMX) PREVIEW FUNCTION 

Together with the DUODMX GATEWAY, the DMX-Configurator software offers the so-called Preview 
function. In the preview, any changes made to the DMX channel controllers are directly visible on the 
DMX device. Thus it is possible to directly test and change the sequences and scenes, if necessary, 
without having to transmit the configuration beforehand.  
 
Note: Please note that the DMX preview permanently sends values until the DMX-Configurator is closed 
and the preview is activated. If you tried to control the DMX channels via the corresponding bus system 
during the transmission of values, the commands of the bus system would be overwritten by the 
activated preview. So make sure to use either the preview or the appropriate control system (KNX/TP, 
KNXnet/IP, EnOcean).  
 
There are two preview variants: 
 

1. Broadcast preview:  All DUODMX devices within the network are addressed by the preview, 
irrespective of the network settings and whether they comply with those of the PC on which 
the DMX-Configurator has been started. The preview signals are transmitted to the network by 
broadcast.  
 

2. Unicast preview:  Only the selected DUODMX GATEWAY receives the preview signals. In this 
context it is important to make sure that the desired gateway and the PC are within the same 
network range. The signals are transmitted to a certain IP address by unicast.  

 
You can also determine for which of both DMX outputs the preview signals are provided. Got to 
Extension > DUODMX GATEWAY to activate the preview.  
 
The DMX-Out 1 and DMX-Out 2 preview functions stand for the DUODMX GATEWAY interfaces 1 and 2. 
 
Activating the broadcast preview  
In order to activate the broadcast preview, you just have to select one of the two check boxes DMX-
Out1 or DMX-Out2 (or both) and acknowledge your selection with OK. From now on, the preview 
signals are sent to the network via broadcast and are being run by all available gateways (figure at the 
top of the next page. Orange arrow). 
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Figure 15: Broadcast preview 

 
Activating the unicast preview  
In order to direct the preview to a specific device, you must select this device on the DMX Gateways list. 
To this end, you must click on the Search button. All devices within the network are displayed with IP 
address (default setting is the MAC address) and device name. To activate the preview for only one of 
the devices on the list, the desired device must be marked (blue background) and then the preview 
must be ticked to activate it.  
 

 
Figure 16: Unicast preview 

 
Note: The preview is not a setting which must be transmitted to the gateway or saved in the 
project data of the DMX-Configurator . It only has to be activated in the corresponding DMX-
Configurator  and remains activated until the next software start.  
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5.2  SOFT ON / SOFT OFF 

If the DMX channels are switched on and off via the 1Bit object, the dimming value 100% and 0% is set 

directly, i.e. "jumped" directly without intermediate steps.  

With the option "Soft On/Off" a dimming function is activated f or the first 128 DMX channels and 

switching on and off is carried out with intermediate steps and thus slower, softer.  

The activated function "Soft On/Off" causes the DMX channels to be switched on (0% - 100%) and off 

(100% - 0%) with a total dimming time of 5.2 seconds.  

The dimming time will be correspondingly shorter if it is not switched on at 0% or switched off at 100%. 

(Example. If the current dimming value is switched off at 50%, the dimming process is already 

completed after 2.6 seconds).  

The function is activated and deactivated together for both DMX interfaces in the extension menu 

(orange arrow). After uploading the project data, the function is active and the DMX channels 1 - 128 

switch on and off via the 1-bit object with a dimming time of 5.2  seconds. 

NOTE: The function only interacts with the 1-bit object. If a DMX channel receives a dimming value 

during a dimming process, e.g. via the 1 byte object, the dimming process is interrupted immediately.  

 

Figure 17: Soft ON / Soft OFF 

 

 

5.3  FIREWALL SETTINGS 

If a firewall is installed on the client computer, the ports 4042, 4044 and 4045 must be ¯enabled° for 
the DMX-Configurator. 
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5.4  DMX-CONFIGURATOR 

The DMX-Configurator control software is used for the creation of light images (steps) and light scenes 
(scene). The resulting configuration data are transmitted to the device via the network or the SD card. 
Moreover, the preview function shows the changes made at the DMX controllers in the DMX-
Configurator directly on the DMX end devices. The software is suited for any common Windows systems. 
It is provided on the supplied CD or at www.bab-tec.de (Service > Downloads).  
 
 

5.4.1  USER INTERFACE 

The user interface is clearly divided into 5 areas. 
 

1. Administration of scenes 
2. Scene settings 
3. Administration of steps 
4. DMX channel settings 
5. Menu bar for settings 

 

 
Figure 18: DMX-Configurator ² user interface 

 
 
 
Different functions for the configuration of the software and ha rdware can be accessed via the menu 
bar. These functions are separately specified below. 
  

5 2 

4 1 

3 

http://www.bab-tec.de/
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5.4.2  CHANGING THE LANGUAGE 

In order to change the menu language of the DMX-Configurator, you must open the ¯?° (Question 
mark) Menu; after having changed the language, the DMX-Configurator must be restarted. 

 

 
 

 
Figure 19: Changing the language 

 
 
 

5.4.3  GENERAL DATA STRUCTURE 

The light images are entered in two different steps. The first step is to create a scene which forms a 
group for the individual steps of the light sequence. 
 

 
 
A scene may include one or more steps, whereas static light images are created with one step and 
dynamic light images with several steps. 
 
  

PROJEKT

SZENE 1

SCENE 2

STEP 1

STEP 2

STEP 3

STEP 1
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5.4.4  CREATING SCENES 

Before you enter the individual steps, you must select or create a scene.  
 
A new scene is created with the NEW button (orange arrow). A New scene entry appears in the scene 
list (purple arrow). This name is freely editable. The first 15 characters are displayed on the APP. 
 
The Copy button (green arrow) copies the selected scene with all of its steps. 
 
The Delete button (blue arrow) deletes the selected scene with all of its steps. 
 

The arrow buttons  (red arrow) are used for changing the order of the scenes. 
 

 

 
 
 
Note: At the beginning of each scene, the DMX-Configurator  assumes that the corresponding DMX 
channel values have the value ¯0°. Therefore, it might be that a scene adds or does not change your 
DMX values to already existing values. As a consequence, the DMX end device displays incorrect values 
(colours).  
 
This can be avoided if you start each scene with a step with the value ¯1° followed by a step with the 
value ¯0° (for the DMX channels which are not used). There is no fade between the steps and a 
minimum wait time  of 10ms. In this way, each DMX channel is set to the desired value ¯0° before the 
actual scene begins. Depending on the requirements, we recommend that a special scene is created 
which is used for the ¯zeroing° of the desired DMX channels. 

  

Figure 20: Scene list 
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5.4.5  CREATING STEPS 

Steps must be created and edited in order to create individual light images and to connect them with 
each other so that a dynamic light image is formed. Static light images are also possible. 
 
 

 
Figure 21: Creating steps 

 
 
 
Channel controllers are provided for the setting of different DMX values. They are marked with the 
channel number. To reach all 512 DMX channels, you must select the DMX channel range using the 
horizontal slider below. 
You can allocate DMX channel numbers to the additionally provided channel quick-access buttons at 
the Program settings menu item which can then be accessed with a click. 
 
For each step, different DMX values can be set for each channel. Dynamic light images can be created 
by a sequence of several steps with different DMX values. The List of steps includes all steps in their 
corresponding order. The transition between two steps is defined by the fade time and the wait time  
which can be adjusted separately for each step. With the option Change all steps, the changes to the 
fade time and the wait time  are applied to all created steps.  
 
Moving to the right/left  
All present DMX values are shifted by one channel to the right (+1) or to the left (-1). This allows for the 
simple setting of ¯running light° scenes.  
 

  

Step list 

Channel 
controller  

Channel quick-access buttons Moving to the left  Moving to the right  

Fading and waiting time Repetition of scenes 

DMX value 
Direct input  

DMX master 
controller  
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5.4.6  COLOUR PICKER 

The colour picker allows for the easy input of RGB colour values. The three consecutive DMX channels 
(R/G/B values) are allocated to the selected colour. You can access the colour picker by right-clicking 
on the first RGB-DMX channel.  
 

 
Figure 22 : Colour picker selection 

 
 
A menu opens up where you must left-click on the colour picker (orange arrow).  
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The dialogue of the colour picker is available in 2 different illustrations. On the left, there is the default 
illustration (normal style), and on the right, you see the colours in a colour circle (round style). 
 
Select the colours as follows: 
Á Select the colour on the colour illustration. 
Á Select the brightness of the colour. 
Á Click on OK to apply the settings for R/G/B. 

 
 
 

   
Figure 23: Colour picker ² two screens 

 
 
 
Note: Right -click on the controller for colour brightness to set it in the centre for 50% brightness.  

  

Brightness of the colour 

Colour 
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5.4.7  DMX GROUPS  

DMX groups are suited for the simultaneous editing of several channels. There are 16 groups where you 
can combine any channels to form a group. 
 
To create or edit groups, select Settings > Program settings in the menu and go to the Groups tab. 
 

 
Figure 24: Defining DMX groups 

 
Enter the DMX channels forming a group in the input field next to the group name. The DMX channels 
must be separated by a semicolon (;). It is possible that one DMX channel is allocated to different 
groups. 
 
After having defined the groups, they are available in the group selection. If you select a group, the 
selected channels are marked by the control boxes and enabled. They are connected with each other, 
and all channels are set to the same value once you change one of the controllers. 
Any additional channels which are not defined in a group can be manually selected by the control boxes 
and temporarily added.  
 

 
 

  Display of the channels 
arranged in groups 

Group selection 
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5.4.8  DMX MASTER GROUP 

The master group is a specific group. The DMX channels included in the master group are scaled 
according to the master value when being output on the connected interface.  
 
Example 1:  DMX value = 100%;  Master = 50% Č   equals 50% in the output 
 
Example 2:  DMX value = 50%;  Master = 50% Č   equals 25% in the output 
 
 
 
 

 

 
 
NOTE: This element is only  effective for the reproduction (p review) of scenes with enabled 
preview function!  
 
 

5.4.9  BEHAVIOUR OF SCENES  

Scene settings: The actions which are being run after the last step of a scene are defined in the selection 
field of the scene settings (orange arrow). 
Á Repeating scenes: The scene is being run in repeat mode. 
Á Stopping scenes:  After the last step, the execution is stopped. The light image of the last step 

is maintained. 
  

DMX master controller 

Figure 25: DMX master controller 
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5.4.10  SAVING AND LOADING PROJECTS 

In the File menu item, you can save your created scenes and steps as a Project and open them again. 
The created files are saved in the specific *.dx1 format; besides the scenes and steps, they also include 
the channel settings.  
 

 

 
 

5.4.11  EXPORTING AND IMPORTING SCENES 

Moreover, you can separately save individual scenes. This is useful if you need the same scene in another 
project. Use the menu item Scene > Export to save individual scenes. The saved file has the extension 
*.scn. Use the menu item Scene > Import  to add an exported scene to your project. 
 

 

 
 

5.4.12  EXPORTING AND IMPORTING STEPS 

Steps can also be saved separately. To this end, proceed analogously to the scenes. Use the menu item 
Step > Export to save individual steps. The saved file has the extension *.stp. Use the menu item Step > 
Import  to add an exported step to the end of the step list. 
 

 

  

Figure 26: Loading and saving projects 

Figure 27: Scene export and import 

Figure 28: Export and import of steps 
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5.4.13  DEVICE MANAGEMENT 

To combine the individual DMX channels in one device, you must allocate the channels to this device. 
Go to the device management for this purpose. The device management can be accessed via the menu 
item Settings > Device management.  
 

 
Figure 29: Device management 

 
In the left half of the window, the DMX channels are listed individually (address 1 ² 512). Once you have 
marked a channel, you can assign a name and a special colour to this channel. To this end, you must 
access the input screen at the right side. RGB and RGBW devices are defined as follows: 
 
RGB device: 
Á Mark the first channel of the desired DMX device (e.g. channel 1 ¯Ch1°). 
Á Enter the desired name of your DMX device in the Name field of the right-hand configuration 

window (e.g. RGB lamp 1). 
Á Now right-click on the channel and select Add RGB channels. The device management 

automatically adds the RGB channels.  
 
The RGB device is defined. It is named after the name you have assigned in the first channel.  
 
RGBW device: 
Á As above, but select Add RGBW channels in the context menu.  

 
 
 
Note: The number of names that can be assigned in the device management is limited!  
A maximum of 225 names (each with a maximum of 15 characters per name) can be crea ted.  
The default of 15 characters per name is explained by the fact that only 15 characters per DMX 
channel can be displayed in the app. Names with more than 15 characters reduce the maximum 
number of names and are not displayed in the app.  
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5.4.14  APPLICATION SETTINGS 

The settings for the main program are under the menu item Settings > Application settings. 
 

 

 
The settings are divided into several groups. 
 
If you directly load the file during the starting process, you define whether and which project is to be 
loaded during the start of the software. 

¶ None: No project is loaded. 

¶ Load special file: The indicated project is loaded. Select the project file with the field (blue 
arrow). 

¶ Load last file: The previously opened project is loaded. 
 
 

5.4.15  MEMORY LEVEL DISPLAY 

As of DMX-Configurator version 1.6.0.0, there is a memory level display (orange arrow). The DUODMX 
GATEWAY has a total memory capacity of 64 kbyte. The level display shows how much capacity of this 
memory is used up for your current configuration. If you transmit more information to a device, you will 
cause malfunctions. 
 
Note: Some of the memory is used up by the communication objects right after the creation of a 
project.  
 
  

Figure 30: Application settings ² file 
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5.5  EXTENSIONS MENU 

The specific settings for the DUODMX GATEWAY are made in the Extensions menu at the DUODMX 
Gateway extension. Here, the device is connected with group addresses or EnOcean profiles, IP 
addresses are assigned and configuration data are transmitted. Moreover, it is possible to search for 
devices in the network, to activate the DMX preview and to switch between master and slave operation.  
 
 

5.5.1  SELECTING THE DEVICE VARIANT 

Before making the specific settings of the DUODMX GATEWAY, the device variant must be selected. 
When selecting the Extensions menu for the first time, the following options appear: 
 

 
Figure 31: Selecting the device variant 

 
Select the corresponding bus type for your device variant. Overview of bus types / device variants: 
(The marking on the front side shows which device variant you have.) 
 
KNX/BMX is for the following device types:  

DUODMX GATEWAY Standalone (item no. 12041) 
DUODMX GATEWAY IP (item no. 12011) 
DUODMX GATEWAY KNX (item no. 12021) 

 
KNX/BMX SR is for the following device types: 

DUODMX GATEWAY IP SR (item no. 12111) 
DUODMX GATEWAY KNX SR (item no. 12121) 

 
EnOcean is for the following device type:  

DUODMX GATEWAY EnOcean (item no. 12031). 
 
WLAN is for the following device types: 

DUODMX GATEWAY Standalone WLAN (item no. 12041w) 
DUODMX GATEWAY IP WLAN (item no. 10211w) 

 
WLAN SR is for the following device types:  

DUODMX GATEWAY IP SR WLAN (item no. 12111w) 
 
 
Once you have selected the device type, the configuration window for the corresponding technology / 
bus type opens up. This selection is displayed once after the first access of the DUO-DMX Gateway 
extension.  
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5.5.2  KNX/IP CONFIGURATION 

If the DUODMX GATEWAY is a KNX or IP device, the KNX/BMX bus type must be selected for the device 
selection.  
 

 

 
Figure 32 : Device selection ² KNX/BMX 

 
This applies to the following device types: 
 
Á DUODMX GATEWAY IP 

Controlled via the KNXnet/IP protocol (based on the network)  
Á DUODMX GATEWAY KNX 

Controlled via the KNX twisted pair bus (two-wire bus).  
 
In any case, the device is controlled via KNX group addresses but the transmission channel of the 
telegrams is different.  
 
After having selected this bus type, the Extension window with KNX-specific parameters opens up. The 
window is divided into two parts: The left part of the window contains the group address administration 
and the right part of the window contains the connections with DMX and the LAN/KNX configuration.  
 

 
Figure 33: KNX/BMX configuration 

 
  


















































































